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Preface

This guide contains information about installing Kofax Transformation Modules and assumes that 
you have a thorough understanding of Windows standards, applications, and interfaces, as well as 
Kofax Capture.

This guide is for solution integrators who are installing Kofax Transformation Modules or who need 
a description of the installation procedures and requirements.

Kofax Transformation Modules consists of a set of components and either Kofax Capture custom 
modules or additional tools. In this document, the components are also referred to by their module 
or tool name, omitting the product name.

If you downloaded Kofax Transformation Modules from the Kofax Delivery site site, you can 
extract the files from ISO file. Refer to the instruction on the Site. Or, you may have received Kofax 
Transformation Modules as a package that includes electronic media. In this guide, we refer to both 
the extracted files and the electronic media as the product files.

Related documentation
The following documentation is available in Kofax Transformation Modules 7.1.0.

Guides
The following guides are available in Kofax Transformation Modules.

Kofax Transformation Modules Installation Guide
The guide provides instructions for installing Kofax Transformation Modules. In addition, it 
contains information about installation requirements, important installation notes, modifying 
the installation, and uninstalling the product.

Kofax Transformation Modules Thin Client Server Installation Guide
This guide provides installation instructions for Kofax Transformation Modules Thin Client 
Server. In addition, it contains information about installation requirements, important 
installation notes, modifying the installation, and uninstalling the product.

Kofax Transformation Modules Product Overview
This guide provides a top-level overview about Kofax Transformation Toolkit and the new 
features for this version.

Help
The following help systems are available.
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Kofax Transformation - Project Builder Help
This help provides information for creating, configuring, and maintaining a transformation 
project.

Kofax Transformation Modules Document Review Help
This help contains information on how to review and structure documents using the Document 
Review module.

Kofax Transformation Modules Correction Help
This help contains information on how to correct extraction problems on documents using the 
Correction module.

Kofax Transformation Modules Verification Help
This help contains information on how to verify pieces of information on a document using the 
Verification module.

Kofax Transformation Modules Validation Help
This help contains information on how to validate problems on documents using the Validation 
module.

Kofax Transformation Modules Thin Clients Help
This help includes information on the following Thin Client user modules.
• Thin Client Correction. This section contains information on how to correct extraction 

problems on a document.
• Thin Client Verification. This section contains information on how to verify pieces of 

information on a document.
• Thin Client Validation. This section contains information on how to validate problems on a 

document.

Kofax Transformation Modules Scripting Help
This help provides scripting examples and how to use the supported script elements.

Kofax Transformation Modules Server, Knowledge Base Learning Server, and Services Help
This help provides information about how to use these tools when processing documents in 
your solution.

Kofax Transformation - Synchronization Tool Help
This help provides information for integrating Kofax Transformation Modules with Kofax 
Capture so that you can process batches.

Kofax Transformation - XDoc Browser Help
This help provides information on how to use the XDoc Browser.

Kofax Transformation - Project Merge Tool Help
This help provides information on how to merge two versions of the same project.

Kofax Transformation - Image Classifier Help
This help provides information about the image classification technology that is used by 
Statistics Viewer.

Kofax Transformation - Statistics Viewer Help
This help provides information about the various statistics that are collected for your solution.
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 Statistics Viewer will be deprecated and no longer available in a future version of Kofax 
Transformation Modules.

More information on documentation can be found in Access Kofax Transformation Modules 
documentation.

Training
Kofax offers both classroom and computer-based training that help you make the most of your 
Kofax solution. To learn more about training courses and schedules, visit the Kofax Education Portal
on the Kofax website.

Getting help for Kofax products
Kofax regularly updates the Kofax Support site with the latest information about Kofax products.

To access some resources, you must have a valid Support Agreement with an authorized Kofax 
Reseller/Partner or with Kofax directly.

Go to http://www.kofax.com/support/  for:
• Access to product knowledge bases.

Click KNOWLEDGE Base.
• Access to the Kofax Customer Portal (for eligible customers).

Click Kofax Customer Portal and log in.
To optimize your use of the portal, go to the Kofax Customer Portal login page and click the link 
to open the Guide to the Kofax Support Portal. The guide describes how to access the portal, what 
to do before contacting the support team, how to open a new case or view an open case, and 
what information to collect before opening a case.

• Product information and release news
Click Transformation > Kofax Transformation Modules.

• Downloadable product documentation
Click Transformation > Kofax Transformation Modules > Documentation and select a 
document.

• Access to support tools
Click Tools and select the tool to use.

• Information about the support commitment for Kofax products.
For more information on the support commitment, click Learn More.
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Chapter 1

System requirements

For information on supported operating systems and other system requirements, see the Kofax 
Transformation Modules Technical Specifications document on the Kofax Transformation Modules 
Product Documentation site.

This document is updated regularly, and we recommend that you review it carefully to ensure 
success with Kofax Transformation Modules.

Software prerequisites
Kofax Transformation Modules requires the following software to be installed alongside the 
product:
• Runtime libraries for Visual C++ VS2019
• Windows Installer 3.1
• Microsoft .NET Framework 4.8
• Crystal Reports Basic Runtime

• Runtime libraries for Visual C++ VS2010 SP1 (prerequisite for Crystal Reports only)

Most of these programs are included as part of the Kofax Transformation Modules, but there two 
exceptions.

1. If you plan on using an Oracle database connection, you need to install the Oracle driver.

2. The "Crystal Reports Basic Runtime" prerequisite is not installed as part of the Kofax 
Transformation Modules installer and is needed for the Statistics Viewer module only. If you 
are using Kofax Capture 11.0 or later, this prerequisite is installed as part of that installation.

 Statistics Viewer will be deprecated and no longer available in a future version of Kofax 
Transformation Modules.

Security model
Kofax Transformation Modules uses the Kofax Capture security model and does not have security 
settings of its own. The following describes the Kofax Capture security model.
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User login and authentication

Category Authentication and Authorization.

Description User provides login credentials for Kofax application.

Security Details Kofax supports corporate directory systems, such as Active Directory through the
Linked Users and Linked Groups features, which take advantage of the corporate 
infrastructure for authentication and credential management.
Kofax also has an application specific authentication and authorization mechanism 
for convenience. This includes credential management and storage. Stored passwords 
are encrypted. The Linked Users feature must be used to take advantage of external 
systems that provide AES or equivalent encryption.

Client transmission to servers

Category Data in transit.

Description Clients (such as Scan or Validation) transmit to servers.

Communication Database .NET Remoting, SMB.
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Security Details All streams of data in transit can be protected with IPsec to take advantage of network-
level peer authentication, data origin authentication, data integrity, data confidentiality 
(encryption), and replay protection.
Details on the streams used are as follows:
Database information containing metadata is transferred to and from the database 
using the database manufacturer's client driver. The network protocol varies 
depending on what database is being used. For more information, consult 
documentation from your database manufacturer.
.NET Remoting (TCP 2424) is used for licensing and batch notification traffic. No 
confidential information (nothing related to images or metadata) is transmitted or 
accessed.
Images are transmitted to/from the file system using the SMB (TCP 445) protocol.

Image and metadata storage

Category Data at rest.

Description Image and metadata is stored.

Security Details Images are stored in the file system and can be secured through use of Windows 
file system permissions. As additional protection, the Kofax environment should be 
configured with the SecurityBoost feature that prevents user accounts from accessing 
the file system outside the application.
Images can be also optionally be encrypted via Microsoft BitLocker or Microsoft 
Encrypting File System (EFS).
Metadata is stored in the Kofax database, which is accessed through a configured 
system account, or by assigning permissions to each user. Database level encryption is 
also available by using the encryption feature within the database itself.

 When using Microsoft SQL Server, you must set the "Store batches in SQL 
Server" configuration setting to ensure all metadata is stored in the database. 
Oracle or IBM DB2 do not offer a comparable setting, as all metadata is always 
stored in the database.

Whether or not file system and/or database encryption is enabled, passwords (for 
external systems or application-specific users), are further protected. Passwords 
are always stored using the Triple DES encryption algorithm and the SHA1 hashing 
algorithms approved by the Federal Information Processing Standard (FIPS) Publication 
140-2 standard.

10



Chapter 2

Installation

This section describes how to install Kofax Transformation Modules and maintain an existing 
installation.

Important installation notes
This section lists important notes for installing Kofax Transformation Modules.

Administrator Rights
To install the product, the logged-in user must have Administrator rights on the local computer.

Install Kofax Capture first
The Kofax Transformation Modules installation installs and registers custom Kofax Capture 
components only if a certified version of Kofax Capture, formerly known as Ascent Capture, is 
detected on the computer. To use the custom Kofax Capture components, you must install a 
certified version of Kofax Capture before you install Kofax Transformation Modules.

Close Applications
Before installing Kofax Transformation Modules 7.1.0, you must close the Kofax Capture 
Administration module on every workstation.

Microsoft .NET Framework 4.8
Microsoft .NET Framework 4.8 is a prerequisite for Kofax Transformation Modules.

Change, Repair and Remove the Installed Version
If you need to change, repair or remove the current Kofax Transformation Modules version start the 
setup from your installation media once again and select the corresponding button.

 Ensure that you do not attempt to change, repair or remove the installed version by 
running the KTM.msi file that is included in the ISO. Doing so can cause errors and corrupt your 
installation.

Kofax Transformation Modules and Kofax Search and Matching Server
When you upgrade Kofax Transformation Modules to the new version and you want to use remote 
fuzzy databases you also have to upgrade Kofax Search and Matching Server to version 6.8 or 
newer. If you do not synchronize the Kofax Transformation Modules and Kofax Search and Matching 
Server versions any search requests on the remote fuzzy databases will fail.
Batches performing such failed search requests are sent to Kofax Capture Quality Control
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KTM Statistics Export Connector Installation
If you want to use the KTM Statistics export connector to gather statistical data you need to ensure 
that this feature is installed in the same location as the Kofax Transformation - Server.

 KTM Statistics Export Connector is not supported on Windows Server 2016.

Help Settings
In order to display the Kofax help correctly you need to ensure that your browser has scripting 
enabled. Otherwise, the table of contents and the search and index tabs may not be displayed 
correctly and context-sensitivity does not work.

Installed version
All Kofax Transformation Modules components such as design applications, runtime servers, and 
end-user modules must have the same installed version. This applies to service packs and fix packs 
as well as other versions.

Install Kofax Transformation Modules
Installing Kofax Transformation Modules involves the following basic steps, which you should 
perform in the order listed.

You must install Kofax Transformation Modules on each machine where Kofax Capture is installed 
and where you want to process documents.

If you are upgrading by installing this version overtop of an older version, please
1. Shut down any applications (including Control Panel, virus detection software, and toolbars) 

that may be running on the Kofax Capture workstation where you are installing Kofax 
Transformation Modules.

 If you are upgrading from a previous version of Kofax Transformation Modules, please 
reboot your server before starting with the installation. Once the machine has restarted, 
reboot it a second time. This is necessary in order for the install to succeed over top of 
the existing version. These restarts are not necessary if you are not upgrading an existing 
installation.

2. Mount the KofaxTransformationModules-7.1.0 image file.
The contents of the image file are loaded automatically.

3. Open the Kofax Transformation Modules folder and then double-click on Setup.exe.
You must have at least 1 GB of free space available on your local C: drive during the installation 
process, regardless of which drive you choose for the installation.
The Kofax Transformation Modules installer window is displayed.

4. Follow the instructions presented to you by the Kofax Transformation Modules Setup 
Wizard.
The installation instructions contain additional information to guide you through the 
installation process. Be sure to read the instructions carefully before proceeding with each 
step.
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5. Select the Custom Setup step in the Setup Wizard to select which features you want to install:
• Click the icon of the feature you want to change and choose the method from the list.

You can see additional information about the feature in the right section of the prompt. For 
example, information is displayed about the required space on your hard drive.
By default, the complete Kofax Transformation Modules functionality is installed. However, 
for Validation, only one step or instance of the module is installed. If you want to use 
multiple Validation steps, remember to select them in the installation tree.

 The Check and Cursive Recognition Add-On engine is now deprecated. However, if 
you used this feature in a previous release, it is necessary to install this Add-On in order to 
continue to use these locators or to migrate an A2iA Zone Locator.
For more information on migrating an A2iA Zone Locator, see the Project Builder Help.
The Cursive Page Recognition Add-On is now deprecated and is no longer available for 
use. Any existing Cursive (A2iA DR 9.1) page profiles are converted automatically to an 
OmniPage page profile with default settings.

• Click Browse if you want to change the installation location of Kofax Transformation 
Modules.

• Click Reset if you want to install the features in default mode.
• Click Disk Usage if you want more information about the required and available disk space 

on your volumes.
Highlighted volumes indicate that you do not have enough disk space for the selected 
features.

6. Click Next, and then click Install to begin the installation.
7. Click Finish.

If you have installed .NET as part of the Kofax Transformation Modules installation, you need to 
restart your computer for the changes to take effect.

8. Repeat the installation on each workstation on which you want to run Kofax Transformation 
Modules.

 If Kofax Transformation Modules is installed, the installation process automatically 
registers the modules with Kofax Capture. If for any reason the custom components 
need to be re-registered, you can manually register them from within the Kofax Capture 
Administration module.
If you install Kofax Transformation Modules on a standalone system and the Kofax Capture 
Administration module is running, an error message informs you that you must close the 
Kofax Capture Administration module before you can continue the installation.
In a client/server environment, if one client has the Kofax Capture Administration module 
open and you attempt to install Kofax Transformation Modules on another client, the 
registration of the custom components fails and needs to be registered manually. For details 
see Registering Custom Modules.

Install Oracle drivers for Kofax Transformation Modules
If you are using an Oracle database, it is necessary to install the Oracle driver.
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You can install the driver by following these steps:
1. Navigate to the Oracle driver website at https://www.oracle.com/database/technologies/

dotnet-odacdeploy-downloads.html.
2. Under to ODAC XCopy section, download the "ODAC XCopy 64-bit ODAC 21c" driver zip file.
3. Unzip the Oracle driver zip file.
4. From the extracted files, copy <extractedfiles>\odpm\odp.net\managed\common

\Oracle.ManagedDataAccess.dll and copy it to the locations on the server where Kofax 
Transformation Modules is installed.
The default installation paths are as follows:
• C:\Program Files (x86)\Common Files\Kofax\Components

• C:\Program Files (x86)\Kofax\Transformation

 If the installation path has been configured to use a different location than the default 
path, then please adjust accordingly.

5. Restart the Kofax Transformation Modules - Scheduler service.
The service restarts and it is now possible to configure an oracle database connection.

Configure a Server Scheduler port number
You can configure the Server Scheduler port number if the default port (5000), is already blocked by 
other programs or services.

1. From the Start menu, select Run.
2. Type regedit and press Enter.

The registry editor is displayed.
3. Browse to the following registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\Kofax\Transformation\4.0\Server

4. Create a string value that specifies the Server Scheduler port number.

a. Right-click the right-hand pane, select New, and then select String Value.

b. Name this string value "SchedulerCommunicationPort".

c. Double-click the string value.
The Edit String window is displayed.

d. In the Value data box, type the port number that you want to use for this service.
The default port number is 5000.

Server Scheduler Service and Knowledge Base Learning Server services
Initially, the Server Scheduler Service and the Knowledge Base Learning Service are installed to run 
under the local system account. If wanted, you can set the Server Scheduler Service user during 
installation by running the installation from the command line. Additional parameters are provided 
that allow setting the user name in the following format: <domain or computer name\user name>.

To run the installation from the command line, type the following command:
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setup.exe SCHEDULERUSERNAME=MyMachineName\ServerSchedulerUser1 
SCHEDULERUSERPASSWORD=MyPassword2011

 The user account for the Server Scheduler Service must already have the permission to "Log 
on as a service" as otherwise the service cannot be started. In case the permission has not been 
set for this user account and need to change the permission and start the corresponding service 
manually. For more information, see Microsoft documentation.

The initial startup type for the Server Scheduler Service is "Automatic"; for the Knowledge Base 
Learning Service it is "Manual". The Server Scheduler Service is by default configured that you need 
to start Server application in order to start batch processing. You can activate automatic batch 
processing by selecting the "Automatic start batch processing" setting in the Service Configuration. 
When installing from the command line you can use the AUTOSTARTBATCHPROCESSING parameter 
to configure the service to automatically start batch processing.

 After the Kofax Transformation Modules installation is complete you can change the settings 
of the Server Scheduler Service and the Knowledge Base Learning Service as needed by the help 
of Kofax Transformation - Service Configuration.

For further details, see Setting up Kofax Transformation -Services in the  Kofax Transformation Modules 
Configuration Guide or  Kofax Transformation - Server and Services Help.

Change the Server Scheduler timeout period
By default, a failed child process times out in the Server Scheduler after 24 hours. You can change 
the timeout duration by adding a Registry entry, ExtractionProcessTimeout.

1. In the Registry Editor, select the following key:
• For x64 operating systems: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Kofax

\Transformation\4.0\Server
• For x86 operating systems: HKEY_LOCAL_MACHINE\SOFTWARE\Kofax\Transformation

\4.0\Server
2. Right-click the key and select New > DWORD (32-bit) Value.
3. In the Name field, enter ExtractionProcessTimeout.
4. In the Data field, enter the duration of the timeout in minutes. The default is 1440 for 24 hours.
5. Restart Server Scheduler.

Install the Natural Language Processing engine language packs
Before you can use either the Named Entity Locator or the Sentiment Locator it is necessary to 
install the Natural Language Processing engine language packs. The Natural Language Processing 
engine performs natural language processing and is able to extract items such as named entities 
and sentiments, but it requires at least one or more language packs to be installed.

For more information on the Natural Language Processing engine and its supported locators, refer 
to the Kofax Transformation Modules - Project Builder Help.

Download the Natural Language Processing engine language packs from the Kofax Delivery site.
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You can install the Natural Language Processing engine language packs by following these steps:
1. Extract the downloaded zip file.
2. Navigate to the MicroPackage folder in the extracted files and double-click on one of the 

following .MSP files, depending on what languages you are supporting.
• KofaxTransformation_SalienceV6.4.0_LanguageBundle_western-default.

Run to install English, Spanish, Portuguese, French, and German support.
• KofaxTransformation_SalienceV6.4.0_LanguageBundle_western-extended.

Run to install Italian, Romanian, and Dutch support.
• KofaxTransformation_SalienceV6.4.0_LanguageBundle_extended.

Run this to install Japanese, Chinese, and Korean support.

A Windows Installer window is displayed and then installs the selected Kofax NLP (Natural 
Language Processing engine) languages automatically.
The installer window closes when the installation is complete.

3. Optionally, double-click on another installer if you want to support additional languages.

Project Builder application mode
When Kofax Transformation Modules is installed, two different modes of Project Builder are 
installed. Each mode has a different icon so that you can differentiate them.

1. Original Project Builder .
Use this to create, configure, and maintain a project. Users of this mode are typically Project 
Designers.

2. Project Builder (Limited to Online Learning) .
Use this to maintain online learning. Users of this mode are interested in downloading 
new training documents, maintaining online learning data, resolving training conflicts, and 
performing benchmarks only. Users of this mode do not have access to any other aspects of 
project configuration.

Use quiet mode installation
If you do not want to perform an interactive installation of Kofax Transformation Modules by using 
the executable, you can use Quiet Mode via the Command Prompt. This type of installation does not 
display configuration, progress, feature information, or warning windows, although error messages 
are still displayed. This is ideal if you are installing user modules or specific components across a 
network because you do not have to visit each machine individually.

You can use Quiet Mode installation to automate the installation of the user interactive modules 
(Validation, Correction, Document Review, and Verification) on target systems.

By default, the complete Kofax Transformation Modules functionality is installed by running the 
setup executable with the Quiet Mode parameter at the command prompt. For more information an 
installing or excluding various components from the install, there are a list of supported parameters
that you can add to the installation command.
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 If any of the prerequisites are installed during quiet installation, it is necessary to reboot your 
system after the installation has finished in order for Kofax Transformation Modules to function 
correctly.

For example, by default, there is only a single step of Validation installed. If you want a second 
Validation step, you can add the VALIDATION2=1 parameter to the installation command. Similarly, 
the VALIDATION345=1 parameter installs an additional three steps for Validation. If you want all 
five steps, use both of these commands.

 By default, Server is installed. To configure the Server and Knowledge Base Learning 
Server services, you need to start Kofax Transformation - Service Configuration after the Kofax 
Transformation Modules installation is complete.

You can install Kofax Transformation Modules using the command prompt by following these steps:
1. From the Start menu, select Run.
2. Type cmd and press Enter.

The Command Prompt window is displayed.
3. Change to the folder that contains the Kofax Transformation Modules Setup.exe file.

 If the setup.exe file is located on a network drive, remember to map to the network drive 
first.

4. Run setup from the command line, using the relevant parameters.
For example, type the following command to install only the Validation module with all steps, 
Correction, Document Review, and Verification modules:
setup /quiet NOPROJECTBUILDER=1 NOSERVER=1 VALIDATION2=1 VALIDATION345=1

Parameters
The following parameters are available for the silent installation.

Parameters for Silent Installation

Setup.exe Parameters Description and Value Settings

/? Shows the help window.

/quiet Runs the installer with no user interaction.

/log [filename] Writes the installer log messages to the specified file.

/uninstall or /u Uninstalls the product.

/install or /i Installs the product.

The following values are available for the property parameter.
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Values for Property Parameter

NOPROJECTBUILDER=1 Disables Kofax Transformation - Project Builder 
installation.

STATISTICS=1 Enables Kofax Transformation - Statistics Viewer 
installation.

 Statistics Viewer will be deprecated and no 
longer available in a future version of Kofax 
Transformation Modules.

NOMODULES=1 Disables installation of all modules in Kofax 
Transformation Modules. None of Server, Validation, 
Correction, Document Review, Verification nor KTM 
Statistics are installed.

NOSERVER=1 Disables Kofax Transformation - Server installation.

NOVALIDATION=1 Disables Kofax Transformation - Validation 
installation.

NOCORRECTION=1 Disables Kofax Transformation - Correction 
installation.

NODOCUMENTREVIEW=1 Disables Kofax Transformation - Document Review 
installation.

NOVERIFICATION=1 Disables Kofax Transformation - Verification 
installation.

STATISTICSEXPORT=1 Enables KTM Statistics Export Script installation.

VALIDATION2=1 Selects additional Validation step 2 for installation.

VALIDATION345=1 Selects additional Validation step 3 - 5 for installation.

ALLADDONS=1 Selects all available Add-Ons for installation.

A2IA=1 Selects Check and Recursive Recognition, powered by 
A2iA, as an additional locator optimized for extracting 
handwritten data from documents and checks for 
installation.

CLIENTINSTALL=1 Allows the installation of Kofax Capture custom 
modules, such as Server and Validation, without 
registration and without license ID registration for a 
client installation, especially if no network is available.

AUTOSTARTBATCHPROCESSING=1 Activates the "Automatic start of batch processing"
setting of the Server Scheduler Service. By default, 
this setting is deactivated when installing the Server.

SCHEDULERUSERNAME=MyMachineName
\ServerSchedulerUser1

Sets the account for the Server Scheduler Service to 
use the specified user. By default, the account runs as 
local system account.

SCHEDULERUSERPASSWORD=MyPassword2013 Sets the password for the Server Scheduler Service 
account.
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KBSERVICEUSERNAME=MyMachineName
\ServerSchedulerUser1

Sets the account for the Knowledge Base Learning 
Service to use the specified user. By default, the 
account runs as local system account.

KBSERVICEUSERPASSWORD=MyPassword2013 Sets the password for the Knowledge Base Learning 
Service account.

NOPREREQUISITES=1 Using this parameter the installation does not check 
the prerequisites and can be used as workaround 
to install Kofax Transformation Modules when the 
installation using the main installer fails.

Activate the Kofax Transformation Modules License
Kofax Transformation Modules is initially installed with a demonstration license for Project Builder 
that is valid for three days. During this time, you can use Project Builder without restrictions.

After the demonstration license expires, only the Activate License window is displayed in Project 
Builder.

You can activate the license either by a software license or a Kofax Capture hardware key, which 
must be present at the time of activation. Administrator rights are required on the computer on 
which the license is being activated.

When activating the license, you must provide a user name and company name.

For more information, see Kofax Transformation - Project Builder Help > Activate the Kofax 
Transformation Modules License.

Additional Kofax Capture configuration settings
It is possible to configure several transformation settings in the Kofax Capture ACConfig.xml file 
located in the \CaptureSV\Config directory.

You can configure the following settings by manually adding an entry to the ACConfig.xml file as 
needed:

ConfigurationSet
This setting indicates the name of the configuration set. For more information on configuration sets 
and how to use them, see the  Kofax Transformation - Project Builder Help.
Example:
<ACConfig>
.
. 
   <Transformation>
.
. 
  <ConfigurationSet Name="Production" />
.
. 
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   </Transformation>
</ACConfig>

Services
You can add an entry that ensures that services do not char log on credentials. This forces a service 
to log on using specified username and password credentials from the service configuration rather 
than using the user configured as the service account.
Example:
<ACConfig>
.
. 
   <Transformation>
.
. 
  <Services ShareCredentials="0" />
.
. 
   </Transformation>
</ACConfig>

AppData
This setting redirects user settings for the rich-client user modules related to docking, toolbar 
customizations, filtering, and Document Review custom menus, and saves them in the AppData
folder rather than the LocalAppData folder. When this setting is not present, or its value is set to 0, 
then that everything is saved to the LocalAppData folder.
Example:
<ACConfig>
.
. 
   <Transformation>
.
. 
  <AppData UseRoaming="1" />
.
. 
   </Transformation>
</ACConfig>

Configure batch opening behavior
For the user modules, it is possible to configure hidden columns to appear on the Open Batch
window by editing the ACConfig.xml file.

 Ensure that any modifications made to the ACConfig.xml file do not cause problems with 
Kofax Transformation Modules or Kofax Capture.

You can configure different columns for different user modules, or configure the same columns for 
all user modules.

The following table shows the user module and the corresponding module Id that is used in the 
configuration file.
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Module name Module Id name

* All user modules

Validation LCI.Validation

Validation - Step 2 LCI.Validation2

Validation - Step 3 LCI.Validation3

Validation - Step 4 LCI.Validation4

Validation - Step 5 LCI.Validation5

Correction Kofax.Correction

Document Review Kofax.DocumentReview

Verification Kofax.Verification

If you want different columns for different user modules, it is necessary to have multiple <Module 
ModuleId=Module Id name> entries in the configuration file. If you want all user modules to have 
the same columns, set the Module Id="*" and add columns.

You can add the following columns to the Open Batch window by adding them to the configuration 
file:
• TheColName

• ColBatchClass

• ColDate

• ColStatus

• ColPriority

• ColQueue

• ColErrorStatus

• ColStationId

• ColExternalBatchId

• ColScanStationId

• ColScanUser

• ColBatchField

• ColDocumentCount

• ColPageCount

The following example shows extra columns for two user modules:
<ACConfig>
.
.
. 
 <Transformation> 
  . 
  . 
  <Modules> 
   <Module ModuleId="Kofax.Verification"> 
    <OpenBatchWindow> 
     <HiddenColumns> 
      <HiddenColumn Name="ColPageCount" /> 
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      <HiddenColumn Name="TheColName" /> 
      <HiddenColumn Name="ColStatus" /> 
      <HiddenColumn Name="ColErrorStatus "/> 
     </HiddenColumns> 
    </OpenBatchWindow> 
   </Module> 
   <Module ModuleId="Kofax.DocumentReview"> 
    <OpenBatchWindow> 
     <HiddenColumns> 
      <HiddenColumn Name="ColDocumentCount" /> 
      <HiddenColumn Name="ColPageCount" /> 
      <HiddenColumn Name="ColStatus" /> 
     </HiddenColumns> 
    </OpenBatchWindow> 
   </Module> 
  </Modules> 
  . 
  . 
 </Transformation>
.
.
.
</ACConfig>

Upgrade Kofax Transformation Modules
The first time you open an earlier project in Project Builder after the upgrade, a list of upgrade 
warnings indicating how to make your project compatible with Kofax Transformation Modules 7.1.0 
is displayed. Once upgraded, these projects are no longer compatible with older versions of Kofax 
Transformation Modules.

If however, you upgrade from Kofax Transformation Modules 5.5, you can simply install Kofax 
Transformation Modules 7.1.0 over top of the existing installation by following the installation 
instructions.

If you have Project Planner installed from a previous version, you need to uninstall this feature first 
before updating to this product.

 If you have a project that you created in an earlier version of Kofax Transformation Modules, 
ensure that none of your classes have child classes with the same name with a different case. For 
example, if you have a parent class called FL_CustomerID and then that class has a child class 
called FL_Customerid, this is not allowed because class names are no longer case sensitive. As 
a result, to ensure that any batches using the project do not generate errors, open your project 
before the upgrade and then rename the child class so that the names are different.

If you upgrade Kofax Transformation Modules and it has user-defined user credentials for 
the Server Scheduler Service and Knowledge Base Learning Service, you should install Kofax 
Transformation Modules using the command prompt and the quiet mode. This allows you to set 
the user name and password for these services. If you do not use the quiet installation mode, any 
existing log on information is overwritten and the services are run using a local system account 
after the upgrade.

22



Kofax Transformation Modules Installation Guide

Databases and connections
If you are upgrading from Kofax Transformation Modules 6.0 or older, databases are now 
represented by both a database and a connection. When loading projects files created with previous 
versions of Kofax Transformation Modules, the connections are automatically separated from 
databases.

If multiple Kofax Transformation Modules databases reference tables that are located in the same 
relational database, they may use the same connection string. In this case, only one connection is 
created.

Upgrade new samples
If you are upgrading from Kofax Transformation Modules 5.5, the way in which New Samples and 
the training sets are handled has changed, and as a result, the training sets and then the New 
Samples database needs to be converted to a new format so that they are compatible with the 
new version of Kofax Transformation Modules. If a project created in an earlier version contains a 
large number of New Samples, the conversion of this database may take a long time. Also, during 
conversion the New Samples database is locked, so this can cause processing delays.

 During conversion the New Samples database is locked, so this can cause processing delays.

To avoid time-consuming upgrades or processing delays, the best practice for projects that use 
online learning is to process any New Samples training documents before upgrading Kofax 
Transformation Modules.

 When processing your reported problem samples, ensure that the Filter is set to <no filter>. 
If you do not remove the filter, you cannot see any of the previously trained documents, and for 
reported problem samples, these documents may not be required and should be deleted.

If however, you want to upgrade your New Samples rather than process them beforehand, there 
are two methods for upgrading the New Samples database after upgrading Kofax Transformation 
Modules. For example, you may not want to delete your reported problem training samples 
for reference purposes. In this case, you need to upgrade the New Samples database after you 
upgrade Kofax Transformation Modules.

1. If you have use the Knowledge Base Learning Server during processing, the New Samples 
database is upgraded automatically. This method is the best practice and should be used for 
any batch class that includes the Knowledge Base Learning Server in its queue.

2. If the Knowledge Base Learning Server is not included in a batch class queue, then the New 
Samples database should be upgraded manually. Open the project, upgrade the training sets 
when prompted, and then upgrade the New Samples database manually.

Uninstall Project Planner
If you upgrade from Kofax Transformation Modules 5.5 and had Project Planner installed, this 
application is not uninstalled during upgrade. However, it is no longer needed as Trainable 
Document Separation (TDS) is now configured using Project Builder.
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In order to remove Project Planner from your computer you need to perform the following steps.
1. Shut down any applications (including Control Panel, virus detection software, and toolbars) 

that may be running on the Kofax Capture workstation on which you want to uninstall Project 
Planner.

2. Start the uninstall by running Setup.exe in the Kofax Transformation Modules\ProjectPlanner 
of the product files of the installation media.

3. In the Project Planner Setup Wizard select Remove Kofax Transformation -Project Planner.
4. Click Finish.
5. When Project Planner has successfully been uninstalled, click Close.

Register custom modules
The Kofax Transformation Modules installation program automatically registers Kofax Capture 
modules and the statistics export connector with Kofax Capture. If for any reason the custom 
components need to be registered after installation, you can manually register them in the Kofax 
Capture Administration module. For further information, see Kofax Capture Help.

 If the installation program fails to register Kofax Transformation Modules custom components, 
an error message is displayed, and unregistered components are unavailable for use with Kofax 
Capture. For example, if the Kofax Transformation Modules - Validation module is not registered, 
it is unavailable as a queue for a Kofax Capture batch class.

1. In the Kofax Capture Administration module, from the Tools menu, select Custom Module 
Manager.
The Custom Module Manager window is displayed.

2. Click Add.
The Open window is displayed.

3. Browse to and select the appropriate Kofax Transformation Modules registration file as follows:
4. Click Open.

The Custom Modules window is displayed.
5. Select the Kofax Transformation Modules components from the list, and click Install.

Register the Statistics Export Connector
1. In the Kofax Capture Administration module from the Tools menu, select Export Connector 

Manager.
The Export Connector Manager window is displayed.

2. Click Add.
The Open window is displayed.

3. Select the Kofax Transformation Modules registration file (KTMStatisticRelease.inf) for the 
statistics export connector from within the selected folder.

4. Click Open.
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The Add Export Connectors window is displayed.
5. Select KTM Statistics from the list, and click Install.

Maintenance
This section describes how to modify, repair, or remove Kofax Transformation Modules 
components.

Modify Kofax Transformation Modules
The Kofax Transformation Modules Setup Maintenance routine enables you to modify your existing 
installation or select additional components to install.

1. Shut down any applications (including Control Panel, virus detection software, and 
toolbars) that may be running on the workstation on which you want to modify the Kofax 
Transformation Modules installation.

2. Restart the installation by running Setup.exe in the product files. If you are running the 
installation from removable media, the installation should start automatically.

3. Click Change.
4. Follow the instructions, and select the features as needed.
5. Click Next to modify your Kofax Transformation Modules installation.

Remove Kofax Transformation Modules
You can remove (uninstall) Kofax Transformation Modules components using the Kofax 
Transformation Modules Setup Maintenance program.

1. Shut down any applications (including Control Panel, virus detection software, and toolbars) 
that may be running on the workstation from which you want to remove Kofax Transformation 
Modules.

2. Stop all Kofax Capture and Kofax Transformation Modules services.
3. Restart the installation by running Setup.exe in the product files. If you are running the 

installation from removable media, the installation should start automatically.
4. Click Remove to uninstall all Kofax Transformation Modules components.
5. Click Remove once again, and follow the instructions that are displayed.

 While uninstalling Kofax Transformation Modules, the installation program tries to 
unregister Kofax Transformation Modules components. If it fails, you are prompted to stop 
the uninstallation process. The best practice is to stop the process, remove the Kofax custom 
modules from all batch classes using them, and restart the uninstallation.
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User and folder permissions
In order to use Kofax Transformation Modules, various folders and registry keys require specific 
user permissions. This is true for the machine where Kofax Transformation Modules Is installed, as 
well as several client machines where the User Modules are installed. The following section explains 
each module, client, or server specific permissions.

 Access to runtime data depends on Kofax Capture user permissions. For more information 
about Kofax Capture user permissions, please see the Kofax Capture Installation Guide and the
Kofax Capture Administrator's Guide.

All modules and tools require access to the CaptureSV shared folder in Kofax Capture.

For more information relating to Kofax Search and Matching Server permissions, see the Kofax 
Search and Matching Server Installation Guide.

For more information relating to Thin Client Server permissions, see the Thin Client Server Installation 
Guide.

Kofax Capture Module permissions
Kofax Capture modules include all user modules (Correction, Document Review, Validation, and 
Verification) as well as Server, the Knowledge Base Learning Server, and Kofax Search and Matching 
Server Administration.

The following permissions are required for the module user on the machine where the Kofax 
Capture module is installed:

Kofax Capture Module Permission Requirements

Path/Registry Key Permission

<LocalAppData>\Kofax Read/Write

<WindowsFolder>\ktmdef.ini Read

<CommonAppData>\Kofax\KTT Read

Published project location Read

HKEY_CURRENT_USER\Software\Kofax\Transformation\4.0 Full Control

HKEY_LOCAL_MACHINE\Software\Kofax Read

HKEY_LOCAL_MACHINE\Software\Kofax\Transformation Read

Kofax Capture user profiles
There are some additional configuration settings needed whenever you use Kofax Capture User 
Profiles to run a module. This is because a specific user may not have the necessary permissions to 
run these modules.
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If the user accessing a module comes from a Kofax Capture User Profile, provide the following 
additional permissions.
• Add the user to the local Administrator's group.
• Manually configure the DCOM Configuration to grant the user "Local Activation" permission by 

following these steps:

1. Go to Control Panel > Administrative Tools > Component Services > Computers > My 
Computers > DCOM Config.
A list of applications are displayed.

2. Right-click on SharedProfileData and then select Properties.
A properties window is displayed.

3. Click on the Security tab, select Customize, and then click the Edit button.
The Edit window is displayed.

4. Add the user to the settings and grant it to the Local Launch and Local Activation
permissions.

5. Click OK to close the Edit window.

6. Click OK to close the Properties window.

7. Close the Component Services window.

Project Builder permissions
The following permissions are required for the user configuring a project using Project Builder and 
using all other configuration tools, such as theSynchronization Tool:

Path/Registry Key Permission

Windows TEMP directory Full Control

Installation folder Read/Execute

<WindowsFolder>\ktmdef.ini Read

<ProgramData>\Kofax Read/Write

<CommonAppData>\Kofax\KTT Read

<CommonProgramFiles(x86)>\Kofax Read/Execute

Project source directory Full Control

Document source files and directories Full Control

HKEY_CURRENT_USER\Software\Kofax\Transformation\4.0 Full Control

HKEY_LOCAL_MACHINE\Software\Kofax Image Products Read

HKEY_LOCAL_MACHINE\Software\Kofax Read

HKEY_LOCAL_MACHINE\Software\Kofax\Transformation Read

27



Kofax Transformation Modules Installation Guide

Kofax Transformation Modules Server permissions
Both the Server and the Server Scheduler require the same permissions. The originating process 
of the user needs the same permissions as the Server Scheduler as well as the same permissions 
needed to start the Server Scheduler

All spawned processes started by either the Server module or the Server Scheduler inherit the 
permissions from the Server Scheduler user. As a result, this service user must have administrative 
permissions. In addition, the Server Scheduler user must also have access to the Kofax Capture 
Server.

The path and registry permissions required for the Server module and the Server Scheduler are the 
same as all other Kofax Capture modules.

In order to write logs, the Server module and the Server Scheduler user must have Write 
permissions to write logging entries on the local Kofax Capture client (Capture/Local/Logs).

The Server module and the Server Scheduler require Read access for the configured Online 
Learning directory that was configured on the General tab of the Project Settings.

If you plan to use the Kofax Clarity recognition engine, Kofax Transformation Modules Server needs 
access to the following URIs/Ports.

URI Port

licenseapi.kofax.com 443

vision.googleapis.com 443

Knowledge Base Learning Server and Knowledge Base Learning Service 
Permissions

Both the Knowledge Base Learning Server and the Knowledge Base Learning Service require the 
same permissions

The Knowledge Base Learning Server also requires the same permissions as the other Kofax 
Capture modules.

In addition, both the Knowledge Base Learning Server and the Knowledge Base Learning Service 
must have Full Control over the configured online learning directory. This path is configured on the 
General tab of the Project Settings.

Kofax Transformation Modules Statistics Release permissions
The Kofax Transformation Modules Statistics Release user needs to have full control over the 
statistics database directory.

Kofax Transformation Modules Statistics Release also requires the same permissions as the other
Kofax Capture modules.
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Kofax Transformation - Synchronization Tool permissions
All actions performed by the Synchronization Tool require the same permissions as Kofax Capture 
Administration. If the user has the necessary permissions to access Administration, then they can 
access the Synchronization Tool.

29



Chapter 3

Access Kofax Transformation Modules 
documentation

By default, the Kofax Transformation Modules documentation is available online. However, if 
necessary, you can also configure Kofax Transformation Modules to use help offline.

Default online documentation
The full documentation set for Kofax Transformation Modules is available from https://
docshield.kofax.com/Portal/Products/KTM/7.1.0-rh4bj2m5vf/KTM.htm.

To launch the online help for the installed version of the product, click on F1 or select Help from the 
menu.

Use help offline
If you do not want to use the online hosted documentation, it is possible to configure Kofax 
Transformation Modules to use help offline on your internal network.

For Kofax Transformation Modules, this is done in two stages.

1. Implement offline help

2. Configure Kofax Transformation Modules to use offline help

First, you implement how the help is accessed offline and then you configure Kofax Transformation 
Modules to use that implemented help.

To access the help offline, download it from the Kofax Fulfillment Site.

For example, download the KofaxTransformationModulesDocumentation_7.1.0.zip file.

Implement offline help
There are two ways of implementing your offline help.

1. IIS application-based offline help that is visible to your internal network only.
Kofax recommends this method. One reason is because you do not need to copy content to 
multiple machines when Kofax Transformation Modules installed across your network.

2. File-based offline help that is available on your internal network.
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If you cannot use the IIS application-based implementation, you can use this method to install 
the help on a file system visible to all Kofax Transformation Modules.

IIS application-based offline help
This method of configuring your offline documentation requires that IIS is installed on your 
network. If you have a highly distributed Kofax Transformation Modules installation where 
components are installed on several machines, this is the easiest way of implementing offline 
documentation.

IIS application-based offline help uses the Browser language to determine the help language. If 
your Browser language is set to French, the help for any opened user module is displayed in French, 
regardless of the application language of that user module.

The following user modules are localized:
• Document Review
• Correction
• Validation
• Verification
• Thin Client Correction
• Thin Client Validation
• Thin Client Verification

All other applications and modules are available in English only.

Kofax recommends this method for offline documentation because it mimics the behavior of the 
hosted site. Kofax Transformation Modules documentation is designed to use the hosted website, 
so if you require offline documentation, an internal IIS application-based solution is best. If this is 
not possible, you can use File-based offline help.

 If you are using the Thin Client Server its documentation is installed separately. For more 
information see the Kofax Transformation Modules Thin Client Server Developer's Guide.

You can configure offline help to use an internal web server by following these steps:
1. If it not already installed, install the Internet Information Services (IIS) on a server on your 

internal network.
2. Download and extract the KofaxTransformationModulesDocumentation_7.1.0_EN.zip

file from the Kofax Fulfillment Site.
3. Set up the folder hierarchy for the offline documentation.

a. Navigate to C:/inetpub/wwwroot/ and create a folder called Docs.

b. Create a second folder under C:/inetpub/wwwroot/Docs called KTM.
The result is the following folder structure: C:/inetpub/wwwroot/Docs/KTM.

c. Copy the en_US folder and any other language that you plan to use from the extracted zip 
file to C:/inetpub/wwwroot/Docs/KTM.
The result of this should be one or more language folders inside the KTM folder.

The folder hierarchy is set up.
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4. Convert the existing folder hierarchy to an IIS application.

a. Expand the Default Web Site.
The Docs folder is displayed.

b. Right-click on Docs and select Convert to Application.
The Add Application window is displayed.

c. Keep all of the default settings and click OK.
The Add Application window closes and the Docs folder is converted to an IIS application.

5. Set up language redirection.

Language redirection for IIS application-based solutions
If you are using a file system-based solution for offline documentation, the help is able to redirect 
automatically based on the Browser language. However, when you are using an IIS application-
based solution, the help is not able to redirect you to your browser language automatically.

 Redirection to a localized copy of the help is available for user-modules only. However, if you 
are using English only, redirection is still required.

You can configure language redirection for IIS application-based solutions by following these steps:
1. Navigate to the redirection folder included in the

KofaxTransformationModulesDocumentation_7.1.0_EN.zip file.
2. In a separate window, navigate to the application path that you created when you configured 

your IIS application-based offline help.
3. Move the web.config from the redirection folder to the root of your IIS application.

For example, C:/inetpub/wwwroot/Docs/web.config.
4. Move the redirection/bin folder to the Docs folder to the root of your IIS application.

For example, C:/inetpub/wwwroot/Docs/bin/.
5. Restart the World Wide Web Publishing service.
6. Open a user module or a tool and test that the help displays the documentation for your 

browser language.
Optionally, change your browser language to another language that you have installed to see if 
that language is displayed.
Your IIS application-based offline help is configured.

File-based offline help
If you do not want to use an IIS application-based solution for your offline help, you can use a file 
system solution. For the best results, use a location that is visible across your network. If you have 
user modules installed at various sites, each of these need to access the location where the files are 
stored.

File-based offline help is supported by the runtime modules and design-time modules only. The 
rich-client user modules are available in all supported languages but the design-time modules are 
available in English only.
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See the Kofax Transformation Modules Thin Client Server Installation Guide for more information about 
configuring offline help for the Thin Client Server.

 Ensure that each client system has a default browser configured on their machine.

You can configure offline help to use a network folder by following these steps:
1. Download and extract the KofaxTransformationModulesDocumentation_7.1.0_EN.zip

file from the Kofax Fulfillment Site.
2. Navigate to %ProgramData%\Kofax\Transformation\ and create a folder called Help.
3. Copy the en_US folder from the extracted zip file to the Help folder.

Now that you have implemented the folder hierarchy for offline help, you need to Configure 
Kofax Transformation Modules to use offline help.

Configure Kofax Transformation Modules to use offline help
The method for configuring offline help for Kofax Transformation Modules differs based on the type 
of module.
• Runtime modules Help Path such as Validation or Server.
• Design-time modules Help Path tools such as Project Builder or the Project Merge Tool.

Because of this, if you want help for all tools and modules, it is necessary to configure both design-
time and runtime modules.

Design-time modules Help Path
The following modules and applications fall under the design-time category.
• Project Builder
• XDoc Browser
• Image Classifier
• Statistics Viewer

 Statistics Viewer will be deprecated and no longer available in a future version of Kofax 
Transformation Modules.

• Project Merge Tool
• OCR Server

 The design-time modules have help in English only.

You can define the Help Path for your design-time modules to use offline help by following these 
steps:

1. Implement offline help.
2. Open Project Builder.
3. From the File menu, select Options.

The Project Builder Options window is displayed.
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4. Edit the Help Path with one of the following.

Setting Description

If you implemented your offline help to use
IIS application-based offline help:

Enter the root of the application.
For example, http://<localhost>/Docs/
KTM/

If you implemented your offline help to use
File-based offline help

Enter the name of the network folder that you 
configured in the ACConfig.xml file.
For example, C:\%ProgramData%\Kofax
\Transformation\Help\.

5. Save your project.
6. Test the help by pressing F1.

The help should open from the location configured for offline help.
The help for these modules is available in English only. If you change the application language, 
the help is still displayed in English.
If an error occurs, double-check the paths to ensure that they are correct and then try again.

Runtime modules Help Path
The following modules fall under the runtime category.
• Synchronization Tool
• Server
• Document Review*
• Correction*
• Validation*
• Verification*
• Knowledge Base Learning Server

Those modules marked with an asterisk (*) are localized and available in additional languages. If 
you are using the IIS application-based solution for your offline documentation, ensure that you 
configure localization redirection. Both the application language and the browser language must 
be set to one of the supported languages in order for the help to be displayed in that language. All 
other help is in English only.

If you do not use a web server to host your documentation, the following steps must be performed 
on each machine where any of the above modules are installed.

You can configure your runtime modules to use offline help by following these steps:
1. Navigate to %ProgramData%\Kofax\CaptureSV\Config\ and open ACConfig.xml.
2. Add one of the following examples based on your solution and then save the file. The actual 

path specified depends on where the extracted files are located.
<Transformation> 
  <Help Path="<Path to documentation>" />
</Transformation>

An example of using a web server:
<Transformation> 
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  <Help Path="http://localhost/Docs/KTM/" />
</Transformation>

An example using the file system:
<Transformation> 
  <Help Path="C:\%ProgramData%\Kofax\Transformation\Help\" />
</Transformation>

3. Open one of the runtime modules and test the help by pressing F1.
The help should open from the location configured for offline help.
If an error occurs, double-check the paths to ensure that they are correct and then try again.

Return to online hosted help
If you no longer want to use offline help, you can change your configuration and return to online 
hosted help by following these steps:.

1. For the design-time modules, do the following.

a. Open Project Builder.

b. From the File menu, select Options.
The Project Builder Options window is displayed.

c. Beside the Help Path, click Restore Default.
This changes the path back to its original online hosted path.

d. Save your project.
The help accessed by all of the design-time modules is now the online hosted help.

2. For the runtime modules, do the following.

a. Navigate to %ProgramData%\Kofax\CaptureSV\Config\ and open ACConfig.xml.

b. Comment out or delete the entry for Help Path.

c. Save the file.
The help accessed by all of the runtime modules is now the online hosted help.
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